
 

 

 
M539-3 

 

 

Medialon Manager 

Release Notes 

 

  



 

 

 

Trademark Information 

Medialon is a trademark of 7thSense Design Ltd. Product or company names that mentioned in 

7thSense Design Ltd publications are tradenames or trademarks of their respective owners, and 

such trademarks may also be registered in their respective countries. 

Copyright Information 

All Rights Reserved. This document is copyrighted © by 7thSense Design Ltd and shall not be 

reproduced or copied without express written authorization from 7thSense Design Ltd. 

The information in this document is subject to change without notice. 7thSense Design Ltd 

assumes no responsibility for errors, and/or omissions contained in this information. 

Document Revision 

Date Document 

edition 

Software 

version 

Revision details Author/Editor 

March 2019 1 Manager 6.7.1 New release, Manager 6.0-6.7.1 Eric Cantrell 

March 2024 2 Manager 7.1.2 Updated Dominic Turpin 

Sep 2024 3 Manager 7.1.3 Updated Kenny Showler 

M539-3 

www.7thsense.one 

info@7thsense.one 

 

 



Medialon Manager p 1 of 50 

M539-3 | January 2024 

Contents 

About this document ............................................................................................................................. 5 

About Medialon Manager ..................................................................................................................... 5 

How to update Manager ....................................................................................................................... 5 

Medialon Manager Version 7.1.3 ........................................................................................... 6 

Bugs solved ............................................................................................................................................. 6 

What’s new in Manager V7.1.3 ............................................................................................................ 6 

Medialon Manager Version 7.1.2 ........................................................................................... 7 

Bugs solved ............................................................................................................................................. 7 

What’s new in Manager V7.1.2 .......................................................................................................... 10 

Known Bugs and Limitations ............................................................................................................. 10 

Medialon Manager Version 7.1.0 ......................................................................................... 11 

Bugs solved ........................................................................................................................................... 11 

What’s new in Manager V7.1.0 .......................................................................................................... 11 

Medialon Manager Version 7.0.3 ......................................................................................... 12 

Bugs solved ........................................................................................................................................... 12 

Medialon Manager Version 7.0.2 ......................................................................................... 13 

Bugs solved ........................................................................................................................................... 13 

Medialon Manager Version 7.0.1 ......................................................................................... 14 

Bugs solved ........................................................................................................................................... 14 

Medialon Manager Version 7.0.0 ......................................................................................... 15 

What’s new in Manager V7.0.0 .......................................................................................................... 15 

Medialon Manager Version 6.7.3 ......................................................................................... 16 

What’s new in Manager V6.7.3 .......................................................................................................... 16 

Bugs solved ........................................................................................................................................... 16 

Medialon Manager Version 6.7.2 ......................................................................................... 17 

What’s new in Manager V6.7.2 .......................................................................................................... 17 

Bugs solved ........................................................................................................................................... 17 

Medialon Manager Version 6.7.1 ......................................................................................... 18 

Bugs solved ........................................................................................................................................... 18 



Medialon Manager p 2 of 50 

M539-3 | January 2024 

Known issues ........................................................................................................................................ 19 

Medialon Manager Version 6.7.0 ......................................................................................... 20 

New features/feature improvements ............................................................................................... 20 

Bugs solved ........................................................................................................................................... 20 

Medialon Manager Version 6.6.1 ......................................................................................... 22 

Bugs solved ........................................................................................................................................... 22 

Medialon Manager Version 6.6.0 ......................................................................................... 23 

New features/feature improvements ............................................................................................... 23 

Bugs solved ........................................................................................................................................... 23 

Medialon Manager Version 6.5.1 ......................................................................................... 24 

New features/feature improvements ............................................................................................... 24 

Bugs solved ........................................................................................................................................... 24 

Medialon Manager Version 6.5.0 ......................................................................................... 26 

New features/feature improvements ............................................................................................... 26 

Bugs solved ........................................................................................................................................... 26 

Medialon Manager Version 6.4.1 ......................................................................................... 28 

New features/feature improvements ............................................................................................... 28 

Bugs solved ........................................................................................................................................... 28 

Medialon Manager Version 6.4.0 ......................................................................................... 29 

New features/feature improvements ............................................................................................... 29 

Bugs solved ........................................................................................................................................... 29 

Medialon Manager Version 6.3.1 ......................................................................................... 31 

Bugs solved ........................................................................................................................................... 31 

Medialon Manager Version 6.3.0 ......................................................................................... 32 

New features/feature improvements ............................................................................................... 32 

Bugs solved ........................................................................................................................................... 32 

Medialon Manager Version 6.2.0 ......................................................................................... 34 

New features/feature improvements ............................................................................................... 34 

Bugs solved ........................................................................................................................................... 34 

Medialon Manager Version 6.1.0 ......................................................................................... 37 

New features/feature improvements ............................................................................................... 37 

Bugs solved ........................................................................................................................................... 37 



Medialon Manager p 3 of 50 

M539-3 | January 2024 

Medialon Manager Version 6.0.3 ......................................................................................... 41 

New features/feature improvements ............................................................................................... 41 

Bugs solved ........................................................................................................................................... 41 

Medialon Manager Version 6.0.2 ......................................................................................... 43 

Bugs solved ........................................................................................................................................... 43 

Medialon Manager Version 6.0.1 ......................................................................................... 44 

Bugs solved ........................................................................................................................................... 44 

Medialon Manager Version 6.0.0 ......................................................................................... 45 

What’s new in Manager V6 ................................................................................................................. 45 

Licence and 3rd party Software ........................................................................................... 46 

 

 

 

 





Medialon Manager p 5 of 50 

M539-3 | January 2024 

Introduction 

About this document 

This document provides the release notes of the different versions of the Medialon Manager 

software and it should be used by anyone wishing to install or upgrade to a new version of 

Medialon Manager software. These release notes are provided together with the software via the 

7thSense user portal. 

About Medialon Manager 

Medialon Manager is software that turns any Windows® PC into a show controller. Reliable and 

easy to use, Medialon Manager is widely used in simple and critical control applications such as: 

museum media control, theme parks and attractions, live events, architectural video and lighting 

control, convention centre audio and video remote control, etc. 

With Medialon Manager you can control audiovisual equipment using any protocol and network. 

Being software based, it integrates easily with IT for a wide range of applications. Control of audio 

and video streaming, linking to external data sources such as databases, media management, 

and facility-wide show control systems are fast to deploy with Medialon Manager. 

Thanks to its easy graphical programming environment, you can program applications far faster 

than with any other conventional control system. There’s no need to learn how to code or 

compile; Medialon Manager uses a real-time execution engine. Its native synchronization 

capabilities and easy to use Timeline with drag-and drop-programming make it an excellent 

choice for show control applications. And when you need it, creating complex logical tasks and 

automation is just as easy using the same drag and drop tools. 

Medialon Manager is hardware independent and relies on standard hardware from IT or 

audiovisual industries to connect to devices. 

Medialon Manager can run in hidden mode where only custom designed interfaces are visible or 

in user mode allowing live edition. The design of touch screen is greatly improved in Version 6. 

Manager convert on the fly the user designed touch pages to Web ‘touch’ pages that can be used 

on iPad or Android tablets. 

How to update Manager 

The easiest way to update Medialon Manager is by downloading the Windows installer from the 

7thSense user portal. 

https://portal.7thsense.one/online-help/medialon_downloads.html
https://portal.7thsense.one/online-help/medialon_downloads.html
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Medialon Manager Release Notes 

Medialon Manager Version 7.1.3 

Bugs solved 

• Ability to set the startup project from the Showmaster web portal has been restored 

• Showmaster’s web portal would not display icons if internet access was not available 

• Showmaster’s web portal download project feature now retrieves the entire project’s sidecar 

files (user date, image date). 

• When ran on a Showmaster, Script MxM would throw SSL exceptions and fail when used 

• Previous project name would stick across “New Project” calls; fixed to clear the name out to 

force input on save and avoid overwriting a previous project 

• All properties pane Selector / Wizard / Last Value buttons have been restored (they were not 

available anymore) 

• Some Smart Monkeys MxMs could cause load errors of certain MxMs, depending on the load 

order 

• Calling Load Project from the web portal would not work if Manager was not in stop mode. 

• Fixed a crash when setting the Color property of an Enum-type user variable 

• Improved: Some user popups would trigger when a project was being loaded headless on 

Showmaster units, making them seem as if frozen;  Popups should not appear underneath the 

splash screen 

What’s new in Manager V7.1.3 

• Added : contextual menu to delete smart groups   

• Prevent deletion of the running project from the Showmaster web portal 
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Medialon Manager Version 7.1.2 

Bugs solved 

• Object control command did not update LED colour on Web Panel until project was stopped 

then restarted. 

If an Object Control command was used to update the colour values of an LED, it changed on 

local screens, but not Web Panels, until Manager entered Stop, and then Run/Debug. 

• LED Panel objects did not change colour if linked to a variable of type enum. (ex: MIP.VideoStatus) 

if the LED status property was linked to a variable of type enum. 

Changes to the enum value now trigger changes to the LED colour. 

• All open User Screens drew in Panels tab regardless of Current Panel selection. 

When loading a project or switching the panel tab between docked and windowed (double 

click on tab / close window), all open User Screens in the project were drawn in the same 

workspace, even though they didn’t all belong to the currently selected workspace.  

• Setting the status of a Web Panel List to -1 did not always remove the selected item on the 

panel. 

This could occur if there was a task triggered by selection changes in the list, which then 

immediately set the status to -1 (to remove the selection). 

• Commands in the Files Management MxM did not support the $CURRENTPRJ_USERDATA 

macro in file paths. 

• The download command in the HTTPClient MxM did not recognise $CURRENTPRJ_USERDATA. 

• Duplicating a Task caused existing Start Task cues to point to the duplicated task and not the 

original. 

• The Current Panel dropdown contained old screens when the New Project option was invoked. 

The current panel dropdown is now cleared when New Project is selected. 

• Preferences > UserScreen > Font Size did not persist. 

The font size setting for User Screens was not saved when the preferences dialog was closed. 

• The Registration form and related ‘unregistered’ messages have been removed from the 

Manager product range. 

• The LLC transmit packet editor did not allow the Enum type to have commas in the data 

values. 

Example: The following Command definition did not have the desired effect because ‘Enum 

Value To Send’ included a comma: 
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• Editing the Manager.CurrentTime variable could cause Manager to crash. 

When ‘Allow Changing of System Variables’ was selected in Manager preferences, a crash 

would usually occur when changes were made to certain Manager variables (notably Current 

Time). 

• DMX Fades stopped in a long, continuously looping show. 

If a show contained DMX cues, and was setup to run continuously, the DMX fades stopped 

somewhere around 50 days after initial start.  

Note: the actual time was based on when the Manager PC was last rebooted. 

• Preferences > User Screen > Font Size does not persist. 

The font size setting for User Screens was not saved when the preferences dialog was closed. 

• Panel Objects: Setting the Visible property on a panel object that was not on a selected page 

caused the object to incorrectly appear. 

Using ‘Command Object Control: Set Visible’ to change the state of a Panel Graphic Object 

caused the object to always appear, even if it was not on the currently visible page. From 7.1.2 

the visible state is set, but the object will not appear unless (or until) its owning page is made 

visible. 

• Slow memory leak running Manager with a software dongle (.lic file). 

Manager had a continuous memory leak when running with a software file. This lost around 

1MB per hour. 

• The reference button in the properties editor was active for user variables, indicating that this 

was an available feature. 

It is not possible to use a reference to assign the value to a user variable so this button is now 

disabled when viewing properties for a user variable. 

• The network assignment feature in the Showmaster web interface only worked for Lan A. 

The Lan B edit interface is now enabled. The port assignments have also been changed to 

logically follow the port labelling on the Showmaster Pro and LE units. I.e. Network and 

Network2 now refer to LAN1 and LAN2 respectively. 
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• Importing a V6 or Showmaster Editor project file containing extended charset characters in 

Panel objects caused the import to fail. 

• Sluggish performance when using buttons to switch pages in WebPanels. 

In some circumstances Web Panel page change updates had a 2 to 3 second lag, when 

triggered from a Web Panel button. 

• Manager on Showmaster: add autorun on startup if there is an active show set. 

To more closely follow the behaviour of previous Showmasters, it is no longer necessary to set 

the show to autorun through the Manager preferences. Manager, when running on a 

Showmaster PRO or LE, will always enter run mode, if an active show is set. 

• The Showmaster Shutdown Cue is not correctly converted to the equivalent Manager 

Shutdown Cue when importing a Showmaster Editor show into Manager 7.X 

The Shutdown command on Manager has more options than available in Showmaster Editor. 

These differences are now handled correctly when importing a Showmaster Editor file. 

• Remove ‘select target’ when creating a new project on a Showmaster Mini. 

The select target dialog appears when using File > New on a Showmaster Mini licensed 

version of Manager. This is not needed, and has been removed to match the behaviour on 

Showmaster LE and Pro. 

• The file progress dialog stayed open if project conversion failed. 

When importing a Manager V6 or Showmaster Editor file into Manager 7, some failures of the 

import process would cause the status dialog to stay open. 

• MQTT MxM did not support different port numbers. 

The previous MxM always defaulted to port 1883. There is now the ability to change the port 

number in the MxM Configuration. 

• Incorrect error message for failed Manager On Lan connections. 

The status dialog for a failed Manager On Lan connection, contained ‘Success’ in the error 

message, which could be confusing. 

• Showmaster Go has been removed from the Manager Edit Target selector. 

The Showmaster Go is licensed for either Manager Pro or Lite. These targets should be used, 

depending on licence. 

• The Showmaster installer cleared out the licence file when uninstall was used. 

This functionality has now been changed, so that any existing licence is now retained for a 

simpler upgrade process. 

• Showmaster Mini and Manager Lite were unable to open project files. 

There is an issue in Manager 7.1.0 where a project file saved on a Showmaster Mini would 

show an ‘Unsupported platform’ error message when reloading. 

• Icons only appear in the Calendar web interface if the browser PC was connected to the 

Internet. 

• Fixed UDP port binding in the Low Level Communicator. 

Selecting a specific adapter for UDP in the LLC always set the binding to all interfaces. This is 

now resolved.  
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• Fixed timecode resource management in Manager Pro. 

In some scenarios, Manager would assume a timecode resource was incoming only, and 

remove the commands for timecode generation, i.e. start timecode, and stop timecode would 

be missing from the command list. 

• Fixed where reloading Showmaster shows would, in some cases, break resource links. 

What’s new in Manager V7.1.2 

• Beckhoff PLC ADS MxM. 

A brand new MxM is now included to support the Beckhoff TwinCat PLC using the Beckhoff ADS 

protocol. The MxM allows TwinCat script variables to be read from and written to in a Manager 

show. It supports automatic route management, and variable change notifications from the PLC. 

• Brompton Technologies LLC V1. 

An LLC is now included to support the Brompton Technologies image processing range. 

• Showmaster Web Interface: lists ‘Active show’ on the Show Management Tab and ‘Set Active 

show’ Option has been removed from General Settings. 

This change was to remove some confusion around the active show setting on Showmaster. 

The Show Management tab will now highlight the currently loaded show in Medialon Orange. 

• Added help files for the 7thSense Delta MxM. 

Known Bugs and Limitations 

• The precedence for the Modulo operator on text variables has changed from V6.  

Example, the following expression: 

TextDisplay_1.Text= "" +Manager.CurrentTime %8  

displays the last 8 characters of the Current Time in Manager 6, but remains blank in 7. 

To mimic the behaviour from Manager 6, brackets can be used to force the operator 

precedence.  

Example. 

TextDisplay_1.Text=("" + Manager.CurrentTime) % 8 

• The time entry editor in property lister ignores the frame rate for a newly created time variable. 

If a time variable is created, and then the format is changed, times entered in the value field are 

treated as 100 fps instead of the chosen frame rate. 

This only happens for a new variable. To work around, click on the new variable in the lister to 

reload the property editor with the properties for the variable. 
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Medialon Manager Version 7.1.0 

Bugs solved 

• Fixed issue where persistent variables are not being ported when opening a V6 project into V7 

• Fixed issue with wrong file extensions being used when opening/converting a V6 project 

• Fixed Delayed Start option that did not work anymore 

• Fixed the hand cursor’s anchor point when editing panels to be at the finger’s tip 

What’s new in Manager V7.1.0 

• Medialon Manager has been adapted to run natively on Showmaster hardware; 

• Medialon Manager replaces Showmaster Editor for Showmaster units running Manager 

runtime 

• Support for 24drop/50/60/120fps 

• Option to automatically evaluate expressions and objects that have direct links to variables 

when a project enters run mode (experimental feature) 
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Medialon Manager Version 7.0.3 

Bugs solved 

• Fixed a memory overrun that could cause the application to fail to start on certain system and 

various other odd crashes. 
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Medialon Manager Version 7.0.2 

Bugs solved 

• Fixed a crash that occurred when selecting an I/O resource (mrc) from within an mxm 

(Medialon I/O); 

The fix applies to the selection action, unrelated to the resource or plugin type. 

• When copy-pasting a graphical object, the linked variables or expressions are cleared. 

• Fixed an issue where the previously referenced variable linked to a graphical object’s property 

would stay linked when changing the fields to another reference or value. 

• Fixed: duplicating tasks would result in tasks referencing the duplicated task loosing their 

reference to it. 

• Fixed a timing issue that caused WebPanels to freeze and become unresponsive. 
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Medialon Manager Version 7.0.1 

Bugs solved 

• Direct-linked variables in properties were not reloaded properly from a saved state and lost. 

• Fixed an freeze issue if a manual save was triggered at the same time as autosave was 

ongoing. 

• The dropdown menu to select workspace will not trigger a full app refresh if the workspace is 

not changed. 

• Out of bounds argument error would pop up when toggling from viewing a timeline-based task 

to a step-based task after reloading a project if the task tab was opened on a timeline-based 

task. 
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Medialon Manager Version 7.0.0 

What’s new in Manager V7.0.0 

• Better support for High DPI displays. 

• Autosave feature. 

• Automatic start of tasks (replaces the need to script a condition). 

• Direct linking of variables and expressions in UserScreen objects. 

• Use of expressions in Cue parameters. 

• Smart groups feature allows assigning text tags and color tags to various objects. 

• iFrame in WebPanels now allow to use external URLs. 

• “Find This Object” shortcut. 

• “Close All But This” in task view. 

• Align options for UserScreen objects. 

• Contextual menu items for lock/unlock, group/ungroup and move UserScreen objects. 
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Medialon Manager Version 6.7.3 

What’s new in Manager V6.7.3 

• Minor branding adjustments. 

Bugs solved 

Manager 

• Fixed memory leak occurring on use of the Perform() command call. 

• Fixed bad URL used during registration. 
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Medialon Manager Version 6.7.2 

What’s new in Manager V6.7.2 

• New Medialon Ltd branding 

• Support for Showmaster Mini 

Bugs solved 

Manager 

• In some cases, the Show-Control software does not manage properly other processes. This 

regression has been introduced in Manager 6.7.1 and Firmware 2.7.1. 
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Medialon Manager Version 6.7.1 

Bugs solved 

Manager 

• Showcontrol software does not allow to retrieve the command list of a device in the MXM 

Script (QMedialon.Perform Helper dialog box – Alt+P) when the application has been turned to 

Debug/Run mode once. 

• Showcontrol software should not perform a command (except specific ones like 

Register/Unregister/GetObject/GetObjectStatus/GetObjectList) while it is not Running. 

• ‘Perform’ command executed from a MXM might cause Manager crash. WaitTime variable 

from a StepBased is not updated if the task is not displayed. Scrolling listers can generate an 

error. 

• Perform command having no parameter, from the script MXM for example, causes a crash. 

• UserScreen stays opened or closed in WebPanel when Manager goes back to Stop mode even 

if its state is different in Manager. 

• UserScreen position is not always restored properly when Manager goes back to Stop mode. 

• A connection to an Overture system should not decrease the Panel Connection count allowed 

by the Showcontrol Software. 

• The ‘Find’ dialog box does not display properly if the text magnifying settings (DPI) is greater 

than 100% into Windows system. 

• Graphic Objects are not always refreshed when the workspace is modified while Manager is 

running. If too much Graphic Objects have to be refreshed at the same moment, some 

updates can be missed. 

• The Network Error -31 must log ‘The connection has been aborted during the connection 

phase’ instead of ‘Undefined error’. 

WebPanel 

• iPads using iOS 10.3 and more don’t handle properly scrolling. 

• Updating a graphical Object’s property on while it has never been displayed yet in the 

WebPanel could generate a JavaScript error and make it not usable. 



Medialon Manager Version 6.7.1 

Medialon Manager p 19 of 50 

M539-3 | January 2024 

Known issues 

Manager 

• Tasks from imported projects won’t run correctly until the project is saved / reloaded. 

• Sometimes, dialog boxes stay hidden by the splash screen. 

• Sometimes when loading a project, the user screen is in a different position from the one 

saved. 

• Task tab does not repopulate when the Software switches from ‘User Mode’ to ‘Stop’ mode. 

• Local Panel on Microsoft Surface takes single click in ‘Debug’ mode and double click in ‘Run’ 

mode. 

• When importing, tasks with clashing names are not duplicated/renamed. 

WebPanel 

• When scrolling a list that keeps populating in a WebPanel, certain items show as blank even 

though in the Panel tab they show correctly. 

• Toggle buttons on WebPanel do not update their states like Toggle buttons on Local Panel. 
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Medialon Manager Version 6.7.0 

New features/feature improvements 

Manager 

• MxMs, Low Level Communicator Drivers, and Script drivers for MxM Medialon Script are 

displayed in a ‘list’ with a search filter instead of a ‘combobox’ in the device creation dialog box. 

• ‘Object Text Control’ has been renamed ‘Object Control’ and allows to control new properties 

like Enable, Visible, Color, Text Color. ‘Object Control’ can be used in Timelines. 

• Configuration files, MXMs, MRCs and dynamic content moved to Windows’ folder. 

• New Application device variables have been added: ‘CPUUsage’, ‘MemoryUsage’. 

• New Application device variables have been added: ‘HostName’, ‘HostIPAddresses’, 

‘ConnectedWebPanelsIP’. 

• The ‘Dark Flat’ theme has been added and set as the default theme. 

• Enhanced user experience when running under High DPI settings. 

• Enable and Visible properties have been added to Graphical Objects. 

• An OpenCap WebSocket Proxy has been added. It’s a proxy software which allows a Web 

application (running in a browser) to communicate with Manager’s OpenCapXML API server. 

• LonCloud feature has been deprecated and removed entirely. 

WebPanel 

• Bypass WebPanel selection when the project contains only one WebPanel without any 

password. 

Bugs solved 

Manager 

• MXM/MRC help generation is not available anymore in Debug / User Mode / Run because the 

software could be unresponsive. 

• Devices could be added to user groups while the group was not selected; Automatic grouping 

now requires the group to have the focus. 

• Double click on a ‘Enums’ property of an Enum variable to edit its item list causes a crash. 

• Focus is not on search box when Find dialog is opened. 
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• Deleting user groups dragged to a tab that contained tasks would cause a crash and the tab 

would not be removed. 

• Projects saved with passwords longer than 15 characters would end up corrupted. 

• Invoking the contextual menu on graphical objects would cause an exception when starting a 

new project if a project had already been loaded. 

• User variable values would get overwritten with invalid content because expressions get 

evaluated when trying to delete any task. 

• Duplicated LEDs lose the ability to specify a Bitmap per status. 

• Toolbar - setup button is not disabled if the selected MXM does not have any setup option. 

• When a cue is selected in a Timeline, its current time position stays blank. 

• An ‘OnExpression/Case’ cue cannot be modified if a condition becomes invalid after an object 

deletion. 

• In Timelines, Track selection does not work properly. 

• Watchdog does not start when Windows’s User Account Control is enabled. 

WebPanel 

• On recent smartphones, touch events were not properly managed. 

• In WebPanel, Bitmaps are stretched in Button graphical objects instead of respecting the 

image size. 

• Scrolling a list in a WebPanel can unselect the current item. 
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Medialon Manager Version 6.6.1 

Bugs solved 

Manager 

• Sometimes, Threads are not actually started. Because of this, a task cannot run for example... 

• By deleting tasks having Expressions where deleted User Variables were used, a crash can 

happen. 

• On WebPanel, a UserScreen which has been moved by using OpenUserScreen is no more at 

the appropriate location when the WebPanel page is re-opened. 

WebPanel 

• On WebPanel, a UserScreen which has been moved by using OpenUserScreen is no more at 

the appropriate location when the WebPanel page is re-opened. 
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Medialon Manager Version 6.6.0 

New features/feature improvements 

Manager 

• Trace information before to load a device. 

WebPanel 

• Network error traces have been improved in WebPanel. 

Bugs solved 

Manager 

• ‘Pause Task’/’Stop Task’ OpenCapXML commands work but return an invalid ‘wrong state’ 

error code (32). 

• A ‘Start Task’ cue, created by dropping a task in another one, won’t accept a longer task name. 

• WebPanel UserScreens are not opened or closed properly if they don’t belong to the current 

screen. 

• OpenCapHTTPServer can crash when it sends a request to the show Controller. 

• When the show controller receives an OpencapXML request it can hang. 

WebPanel 

• Digital Slider with negative minimum value does not behave properly in WebPanel. 

• Button text are sometimes not vertically centered. 
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Medialon Manager Version 6.5.1 

New features/feature improvements 

Manager 

• When an Enum variable is set persistent, only its current state is saved into the persistence 

storage. Therefore, any changes in the Enum list is not saved/reloaded. Now, all the Enum list 

is saved as part of the Enum variable. This change is backward compatible, however, the 

Enum list will be lost if the project is opened with a previous version of Manager/Showmaster. 

• Added support for Overture OpenCap connections. 

Bugs solved 

Manager 

• The day of the week which is displayed in the Lister for each Date variables is not correct. Only 

the displayed value is affected. A call to the DayOfWeekAsNumber() function in an Expression 

return the appropriate value. 

• StepTaskNameSelector and TimeTaskNameSelector display both the Step tasks and the Time 

tasks. 

• Some MXMs’ specific commands are displayed in the Lister although they are not meant to be 

displayed. 

• Internal changes. 

• Internal changes concerning IO resources. 

• When the menu ‘File->Convert’ has been used, using the menu ‘File->Open’ afterwards, causes 

Manager/Showmaster Editor to crash. 

• WebPanels with a lot of user screens are sometimes incomplete. 

• Sometimes, when using large projects, listers are not updated and tasks cannot be started 

from the GUI after having switched to debug mode. 

• Manager/Showmaster/Editor crashes sometimes when a client Manager/Showmaster is 

disconnected and reconnected by unplugging/replugging the ethernet cable on the client side. 

• Memory leak using perform command from the Script MxM or OpenCapXML. 

• A message indicating that the dongle is not present can appear when Manager is used in the 

same machine as Overture CS or UX. 

• Manager Server with no user/password denies connections from MON clients which are 

configured to use user/password. 
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• Crash of Manager Server if there are a lot of concurrent connections/disconnections of MON 

clients. 

• When the creation of a variable from a User Group view is cancelled, saving the project 

afterwards caused a crash. 

• Task Names are not fully display in task editor when the DPI settings are greater than 100%. 

• The period character (.) was allowed in the create device dialog. Although it was replaced by 

an underscore character (_), the active cursor was moved back to the first character. 

• Delete a WebPanel containing UserScreens causes a crash. 

WebPanel 

• Digital Slider with negative minimum value does not behave properly in WebPanel. 

• Button text are sometimes not vertically centered. 
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Medialon Manager Version 6.5.0 

New features/feature improvements 

Manager 

• The projects loading time has been improved. 

• ‘Don’t ask me again’ option has been added when deleting multiple devices. 

• A hour-glass cursor has been added when multiple tasks are deleted or duplicated. 

• An alert has been added when an assignment is used within a start or logical expression 

(condition). 

• Warnings/Errors concerning Variables which are displayed in the ‘Project File Load Result’ 

have been improved and contain now the name of the object. 

• During the Installation, a checkbox allows to specify the Windows setting associated to the 

software in order to launch it by default this one as administrator. 

Bugs solved 

Manager 

• Incorrect name which includes unsupported characters like ‘ ‘ can be used to create 

dynamically device variables. 

• Save icon/menu is no longer enabled when a new user variable is created. 

• Value of system variables were stored in the project even when it was not required. This allows 

reducing the project size. 

• When a string variable has a limited length, it is possible to set a longer string that this max 

length. 

• The ZOrder variable of an UserScreen is not modified in a LocalPanel in Run mode. 

• In the Task lister, icons indicating that tasks are locked are partially hidden. 

• Affect a String containing alphabetic character to a Time variable does not set its value to 

00:00:00/00. 

• Comparison between a String variable and a String which is formatted as a date like 

01/02/1903 will always return false even if the String variable has the same value. 

WebPanel 

• List objects are not properly updated when the new text contains special characters like ‘|’... 
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• When the text of a ‘List’ object is modified before to display this List in a WebPanel by 

changing page or using Open UserScreen command for example, this List object is not created 

properly and doesn’t allow the user to select an Item. 
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Medialon Manager Version 6.4.1 

New features/feature improvements 

Manager 

• Improved speed of sorting in listers for large sets of items. 

Bugs solved 

Manager 

• When a project containing User groups is unloaded, there is a memory leak. 

• A memory leak happens when a MON Client is destroyed. 

• ‘Object Text Control’ does not update WebPanels (bug introduced in Manager.6.4.0). 

• A crash may happen on MON clients disconnecting. 

• LocalPanel and WebPanel variables node cannot be dragged in order to create a new lister. 

• MXMs created with the SDK may generate a crash when accessing to Enum variables. 

• Some commands like ‘Star Task’, ‘Pause Task’, ‘Stop Task’, ‘Goto Label’ can freeze Manager 

when they are called from the Script MXM. 

• Perform command can be done on an unshared Device via the Script MXM. 

• ‘Start Task’ command from Script MXM fails when the option which allows to automatically 

register all User Groups is enabled. 

• It is possible to give a name containing unauthorized characters to a MON device. This would 

result in expression evaluation errors. 

• UserScreen’s List item #0 is selected automatically when the list gets focus and when no item 

was selected yet. 

• There is no warning when a task is deleted and is also referenced into a Start Task/Call 

Task/etc... cue. 

• A crash can happen when multiple devices containing variables are deleted. 

WebPanel 

• Demo banner can be displayed at the wrong moment. 
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Medialon Manager Version 6.4.0 

New features/feature improvements 

Manager 

• WebPanels can be served as HTTPS pages. 

Bugs solved 

Manager 

• mOpenCapHTTPServer does not answer the status code 304 to inform to a WebPanel that its 

cache already contains the required image and this image has not been modified. 

• The variable ‘ConnectedPanels’ is not updated after a project has been loaded if there were 

connections when the project was saved. 

• The Notes in Preferences->Project are not erased when a new Project is created. 

• Some command parameters cannot be edited after the project is loaded (such as 

DeviceControl’s device name). 

• Entering values for inset properties which exceed the size of the image causes a crash. 

• Load a project using a MXM which requires dependencies (dll) generates a crash if these 

dependencies are not installed. 

• OpenCapXML command could sometimes be falsely rejected. 

• OpenCap and OpenCapXML clients are not notified when a variable is added to the client 

shared group. 

• OpenCapXML command GetObjectList() does not return shared user groups as part as shared 

objects. 

• OpenCapXML command SetProperty() on variable objects doesn’t allow setting the current 

value of an Enum as its index. 

• If a StepBaseTask is stopped during a Wait execution, the Wait Time display in the editor is not 

reset and keep the current wait value. 

• An access violation occurs when the Properties, Browser, Control, or DeviceMap tab is 

dragged into the Lister area which contains a list of UserScreens. 

• The parameter name containing a ‘/’ character are not properly interpreted by 

Manager/Editor/Showmaster for the Perform commands. 

• ‘Object Text Control’ command do not allow to retrieve the Text of an ‘Text Edit’ graphical 

object. 
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• Importing tasks with the update/replace option incorrectly updates start task names. 

• Close a project when a WebPanel screen is displayed in Manager/Editor can generate an 

access violation if one or more WebPanel are connected to it from a browser. 

WebPanel 

• In a List graphical object, if an item is already selected when another one is added, these items 

will be selected. 
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Medialon Manager Version 6.3.1 

Bugs solved 

Manager 

• GetObject OpenCapXML command issued against a parent shared group returns ‘Object or 

Parent not shared’ error instead of ‘Success’. 

• A crash can happen when a project containing UserScreen objects is opened. 

• The text color of the dialog window ‘Project File Load Result’ does not follow entirely the 

current theme. 

• When an ‘Open UserScreen’ command is executed on a screen which has multiple 

UserScreens, the Page variable is updated with the ZOrder value and the wrong page is 

opened. 

• When multiple devices are selected and the Insert Cue menu is invoked but only one device is 

actually selected from this menu, the created cue is ‘attached’ to all previously selected 

devices. 

WebPanel 

• Sometimes a WebPanel cannot be loaded when it contains many UserScreens. The ‘Loading 

WebPanel...’ box is displayed for 20 seconds and then the Main Panel containing the WebPanel 

list is shown with an ‘Invalid ID’ error. 

LonCloud 

• LonCloud stops working when an unknown Controller ID is used in the project. LonCloud stops 

sometimes when a controller is used for the very first time. 
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Medialon Manager Version 6.3.0 

New features/feature improvements 

Manager 

• Now supports the LonCloud service. LonCloud is a cloud-based monitoring service for 

Medialon products. 

• The message which is displayed when the server port cannot be opened, has been improved 

with more information. 

WebPanel 

• WebPanels are now displayed in full screen without the title/location bar when iOS Web Apps 

are used. 

Bugs solved 

Manager 

• Opening a recent project from the ‘Start’ Windows menu can open the specified project with a 

short path form. 

• A crash can occur when deleting a visible timeline task if there are several Task listers. 

• Opening and closing cue editor (such as DMX cue editor) multiple times can cause a crash. 

• The ControlPanel contained into a Container is not displayed if the UserScreen is closed in 

Stop mode or when the ‘Panels’ tab is detached in some case. 

• A project, which has been saved with a detached window on a second screen, will not display 

this detached window on a computer which has only one screen. 

• Issues when disabling/enabling MON device regularly. 

• UserScreens Z-order is not always correct after changing Mode. 

• Move an UserScreen window in a WebPanel has no impact on the others WebPanels. 

• Device ControlPanel are sometimes created even if they are never displayed. 

• Former projects containing legacy MXMs which have added parameters to command cannot 

be loaded. 

• A video executed by the Local Media Player MXM is displayed outside of containers in Kiosk 

mode if the project has been created with Manager Pro or Manager Lite. 

• The device command list is not displayed with the correct order. 
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• The device icon is not fully displayed in the Task area. 

• Messages like ‘StartTask requested by’ initiated by MON doesn’t mention task name. 

• When a project is opened by double-clicking on the project file and if this project is in ‘autorun’ 

mode, WebPanel’s UserScreens are all closed even if they were supposed to be opened. 

• Parameter Autotime of Countdown’s cues cannot be set to No anymore. 

• Sometimes, ‘Replace device’ menu is grayed, although it should be enabled. 

• After a Replace Device command has been performed on a cue, wizard of cue’s parameters 

may not work properly. 

• When a resource is created or deleted, the save button/menu is not activated, therefore the 

changes might not be saved. 

• When the size of all Windows items is 125%, the Demo image can be not properly displayed in 

Manager. Default UserScreen font is not applied to Text object. 

• Multiple devices’ cues were allowed for devices from the same MXM even when they are not 

compatible in between. 

• WebPanel properties are sometimes corrupted after they are been modified by the user. 

WebPanel 

• The ‘Connect’ button from the WebPanel Home page is not displayed on the old version of 

Internet Explorer. 

• List update of large list is very slow in WebPanel. 

• The WebPanel list is not always displayed on the Medialon WebPanel home page. 

• UserScreens Z-order is not always correct after changing Mode. 

• Move an UserScreen window in a WebPanel has no impact on the others WebPanels. 

• With a project which contains a WebPanel with many UserScreens displayed as always and 

top and not displayed. 

• When the ‘Background_Page’ property is set to a page index which doesn’t exist, the WebPanel 

cannot be loaded in a browser. 
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Medialon Manager Version 6.2.0 

New features/feature improvements 

Manager 

• Design of IR driver management has been improved. 

• Internal Module Help generator has been improved to support a new help format. 

• The ‘Revision List’ is accessible from Help menu. 

• Added Cue Index and Cue Time for cues in the Find Result window. 

• When an image is deleted from the image list, it is not clear when its image file is deleted or 

not. This is mainly due to the succession of alert dialog boxes. Additionally, if the image file is 

deleted, it is now moved to the Recycle Bin, instead of being removed from the disk. 

• The option ‘Disabled objects only’ has been added to the Search dialog. This option allows 

searching for disabled objects such as disabled (or invalid) cues. 

• The meaning of alarm and error messages generated after a project loading has been 

improved. 

Bugs solved 

Manager 

• The Inspector is not updated when a screen is selected in the panel editor. 

• Some information is missing in the Error displayed message when a project fails to load. 

• Error when connecting a WebPanel on a large project. 

• The icon of a mxmMedialonLowLevelCommunicator device is not updated when type is 

changed (for example: from TCP to serial). 

• The WebPanel version and the WebPanel HTTP Server version are not defined in the ‘About 

your computer’ dialog box when Manager has been launched in autorun (double click on a 

project). 

• The Control Panel of some MXMs stay black in ‘Run Mode’. 

• When the start condition of a task is true and there is a pause point within this task on a 

command within a while loop, the execution of the task starts to freak out. 

• Wrong warning message ‘String Max Length Missing in XML Element’ on loading project. 

• A crash can when quitting the application with some projects. 

• The message displayed when a duplicated MXM file is detected is not correct. 
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• In some cases, the ‘Perform’ command is not properly executed (for example one call by the 

MXM Medialon Script). 

• The MXM folder path is now part of the application environment variable. Files placed in this 

folder can be referenced by the application or application’s modules. 

• MXM commands which have been modified are not always updated when the project is 

loaded. There is a bad reference in cue parameter when an object associated to this cue is 

deleted. 

• Object names can get duplicated due to invalid chars, such as space, which were allowed for 

these names. 

• The Inspector allows enter a value for command parameters which are output only. This is 

confusing even though it doesn’t do anything. 

• On the first Device creation for an MXM, a crash happens if the Setup is not validated. 

• A task is not always displayed as stopped, when selected in the editor, if a stop is issued when 

the task was previously not visible in the editor (part of a non-visible tab). 

• When Infrared Device setup is opened on a different monitor than Manager or Showmaster 

Editor, ‘Select Infrared Channel’ dialog box does not displayed list of available resources. 

• Unused User images are copied in application data. 

• Some directories are not deleted during the Manager uninstallation. 

• ‘Device Control’ command doesn’t allow a Display to move from a container to another one. 

• In the Task Editor, printing a selection of cues causes these cues to be grouped. 

• When a project is loaded, UserScreen(s) from WebPanel(s) are displayed in the LocalPanel if 

the current panel is the local panel. 

• The WebPanel code is not automatically reloaded in the browsers even if the WebPanel 

version has changed. 

• The commands list from a Device is not displayed in its definition order in Manager/Editor. 

• When the Current Panel is a WebPanel, some commands around Display function (like 

OpenUserScreen) don’t work properly on the Local Panel if Manager is in ‘Run’ Mode. 

• OpenCapXML: GetObject() command does not return the full XML description (including 

commands description) for device objects. 

• On some MXMs, Wizard item selection dialog boxes have their Ok button always grayed, 

prohibiting the selection. The only way to validate the selection is to double-click on the item. 

• Comparing two Real variables using operator != or operator == doesn’t work. 

• The OpenCapXML Perform command is not implemented for the Manager/Showmaster and 

Manager On Network devices. 

• Sometimes, LocalPanel mouse and keyboard variables stop to be updated OpenCap 

connection limit can be reached when clients don’t disconnect properly. 
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• When an image file is selected to be added into the image list, the image is not added if the file 

already exists in the image folder but is not referenced by any image within the list. 

• Pages created using either the ‘Next’ page button or the ‘Move Objects’ menu are not displayed 

in the Browser until the project is loaded again. 

• No answer is given when an unknown OpenCap/OpenCapXML command is received. 

• An access error message against ‘mmwdc6.dll’ could occur during the product installation. 

• Some windows and dialog boxes don’t display properly if the text magnifying settings (DPI) is 

greater than 100% into Windows system. 

• Usage of Min() or Max() functions into expressions could cause a crash if variables are 

involved in that expression. 

• An unnecessary alarm ‘Enum Current Missing XML element’ may be displayed when loading 

former projects. 

• A UserScreen which is defined as ‘Always on Top’ can be hidden behind another UserScreen 

which doesn’t have this property activated. 

• Manager can crash if the dongle is accidentally removed while the project is in Debug or Run 

mode. 

• User Rights settings for cues in Cue Library do not stay after a save and reload. 

WebPanel 

• Sometimes the loading of a page from a UserScreen fails in WebPanel. 

• In WebPanel, the Error panel is sometimes not displayed at the center of the screen. 

• When the current page is modified during a WebPanel connection, this page might be not 

displayed into the WebPanel. 

• WebPanel doesn’t work properly with IOS 6 (iPad, iPhone, iPod). 

• The graphical object ‘List’ doesn’t support up/down arrow keys in WebPanel. 

• WebPanel loading can be done many times when the Manager/Editor/Showmaster status 

changes. 

• The Z order of multiple UserScreens which are defined as ‘Always on Top’ is not properly 

managed. 

• The UserScreens are not correctly positioned after an ‘Open User Screen’ command execution. 
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Medialon Manager Version 6.1.0 

New features/feature improvements 

Manager 

• Default WebPanel creation size settings in the preferences. 

• Log trace selection has been improved and expanded to tasks, cues and modules such as 

MXM or MRC. 

• OpenCapHTTPServer log traces have been improved. 

• MXMs/MRCs can now provide cfg-dist (configuration distribution file) to update/change their 

default settings. 

• The WebPanel version and the WebPanel HTTP Server version are displayed in the menu ‘Help 

-> About your Computer...’. 

• ‘Load Image’ feature from the Image Selector has been improved. It is now possible to either 

update an existing image or to create a new one if the image file is already used. 

• The ‘Select a variable’ dialog now gets the focus in the ‘Find’ field automatically, each time the 

dialog is opened. This dialog box can also be invoked using ‘Insert’ key within the Cue’s 

Properties to select a variable for the current cue’s parameter. 

• A ‘cancel’ button has been added to allow avoiding the launch of Manager when it is run into 

Demo mode. 

WebPanel 

• The error messages, like ‘Too many connections’, are now displayed in the ‘Auto Reconnection’ 

screen in WebPanel. 

• The list of available WebPanels is displayed on the Medialon Web Panel page. 

Bugs solved 

Manager 

• WebPanel variables are not renamed in cues when a WebPanel is renamed. 

• Alarm messages “Task User Control Panel missing in XML” are generated when a KIOSK 

project is loaded into a Manager Pro or Lite. 

• When a project is loaded with AutoRun mode, alarm & error dialogs - if any - are hidden, the 

application seems then hanged. 
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• The cue parameter’s wizard (if any) of the wrong device is called after a device replacement 

has been done on that cue. 

• Watchdog crashes if the same instance of an application tries to be register twice. 

• The depth of some graphical objects is not correctly rendering in relation to other objects. 

• When a task is deleted, usage of graphic objects’ wizard may generate a crash. 

• The menu “File->Install a License File” is grayed when Manager starts. 

• When more than allowed number of WebPanels try to connect a Manager, the connections do 

not complete properly and already connected WebPanels may be disconnected. This also 

occurs when several WebPanels are already waiting for a connection (“Auto Reconnection” 

state) and do connect simultaneously. 

• When the network cable/connection is physically disconnected several times, Manager Panel 

client may not reconnect on Manager Lite, Showmaster ST. 

• Implementation of OpenCapApi’s Perform and PerformEx commands are not following 

specification. 

• When the login or the password for the MON connection are not correct, the connection 

always ends with error “Cannot connect Manager On Network”, not telling about the reason of 

that error. 

• The MON setup dialog box displays a confirmation password field which is not used for a 

client configuration. It has been removed. 

• Access Violation when deleting several variables at once. Cannot use extended ASCII in an Edit 

object from WebPanel. 

• A crash can occurs when a variable or a device is deleted and is also part of a shared group. 

• A cue containing an expression can be stay marked as faulty (red cross line) after a project 

has been loaded, although it is not faulty. 

• List of items of sorted list are not the same between the inner variable and the display when 

there are duplicate entries. 

• Set the Width of a Slider (or a DigitalSlider) object to 2 generates the Warning message: 

‘Division by zero’. 

• ‘Trace Buffer Size’ value of Logs settings can be set outside the accepted range value. 

• When a WebPanel graphic object is duplicated, some properties are reset. 

• When a graphic object referenced in ‘Object Text Control’ cue is renamed, its reference is not 

updated in those cues. 

• It is possible to write something with multi lines in an Edit object when it’s property ‘Single Line’ 

is enabled by pressing Ctrl+Enter. 

• Small memory leak when a new project is loaded. 

• LED status is not changed when the led has a frequency and a sequence defined and is on a 

non-visible page. 
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• DMX recording doesn’t set the Timecode reference parameter properly in the recorded cue 

(Requires mxmMedialonDMX512 6.1.2+). 

• Standard Activity Positrack variables are not affected when the device ‘User Mode’ is changed. 

• SelectedText variable is not updated when a change on the list causes the actual selected item 

to change. 

• OpenCapXML command ‘getproperty’ causes a crash when request object doesn’t exist. 

• The ‘ObjectTextControl’ command has no effect on List objects. 

• When a Panel property is modified: the Object Inspector displays the properties of the first 

UserScreen of this panel. 

• The ‘Find’ field of the Variable Selector dialog doesn’t always have the focus. 

• WebPanel HTTP server is not restarted properly in case of failure (needs MedialonWatchdog 

5.3.0+). 

• Hint of timecode calculator tool for division button is incorrect. 

• Manager (or ManagerPanel) looks like being stuck when opening an auto-run project when the 

current code page of the machine doesn’t match the project code page. 

• Sometimes, WebPanel doesn’t receive the instructions to be refreshed. This happens mainly 

with a WIFI connection. 

• ‘Remove Unused bitmaps’ may remove actually used bitmap files when the same bitmap(s) 

has(ve) been imported more than 1 time. 

• Menu ‘Object->UserScreens->New UserScreen...’ is enabled when no Panels are created but 

does not ask to create a new one. 

• New dongle generation (blue dongle) is not recognized under Windows 8. Crash when deleting 

a device while it used by the last created cue. 

• Misspelled user messages. 

• A crash may occur if a serial resource is not present when a project using that resource is 

loaded. 

• WebPanel default size parameters are no saved. 

• ‘Allow changing value of System variables’ option in preferences has been re-introduced. 

• Invoking a wizard for a selection of multiple cues only changes the first cue. 

• Drag and drop a device on an unselected object doesn’t always create the proper task. 

• Copy/Cut/Paste keyboard shortcuts don’t work in Text Edit controls. 

• Variable selector menu is not available for ‘Object Type’ parameter of ‘Get Object List’ internal 

command. 

• Virtual screen size information is not refreshed when size of a Panel is changed. 

• UserScreen name change doesn’t update related task cues in some circumstances. 
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• Some commands as OpenUserScreen generates a crash when the parameter is a String with 

more than 1024 characters. 

• Slider thumb bitmap is not updated when the bitmap is replaced by another one. The update 

only occurs when switching to Run/Debug mode or when the size of the slider changes. 

• When a device is dragged and dropped on a Container, the DeviceControl cue newly created is 

not always properly displayed. 

• Countdown time value is erratic when no timeout is set for WaitFor command. 

• ‘Select a variable’ dialog opens twice when it is invoked from ‘Insert’ key in the Expression 

editor (when the selector is closed, it is opened again). 

• Time display was not updated properly when switching from a task to another in the task 

Editor. 

• When switching from a task to a timeline in the task Editor, the new displayed timeline is 

sometime not refreshed anymore. 

• WaitFor countdown counter is not paused when the task is paused. The display is paused, but 

the internal countdown is not paused. 

WebPanel 

• The depth of some graphical objects is not correctly rendering in relation to other objects. 

• Sometimes, the WebPanel stays frozen in the browser. 

• WebPanel displays ‘Auto-Reconnection’ when the connection with Manager is lost during few 

seconds. 

• When new URL property in WebPanel button is used, associated task doesn’t start. 

• WebPanel doesn’t auto-reconnect if there’s a password on the WebPanel. 

• An Edit in WebPanel part can be resized when the property WordWrap is enabled. 

• Cannot scroll a list object in a WebPanel on a iPad / tablet. 

• ‘Word Wrap’ property is not supported by text object in WebPanel. 

• List, Button, Display and Text objects do not display multiple spaces. 

• The cursor size of a Slider can be bigger than the Slider’s size itself in WebPanel. 

• Sometimes the Slider’s (or DigitalSlider’s) value is different between WebPanel and Manager 

when the cursor has been moved and released on WebPanel. 

• The ZOrder of graphical objects is not properly supported by Chrome browser. 

• Sometimes, WebPanel doesn’t receive the instructions to be refreshed. This happens mainly 

with a WIFI connection. 
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Medialon Manager Version 6.0.3 

New features/feature improvements 

Manager 

• A new load report window is shown to display load reports, if any, at the end of the load project 

process. 

• Device variables are now reset to a default value after a project is loaded. 

WebPanel 

• New “URL” property for Button Graphic Object (WebPanel only) which allows opening a new 

URL in the WebPanel browser window. 

Bugs solved 

Manager 

• Registration number is asked again when Manager is launched within a non-administrator 

account. Administration privilege needs are not mentioned when the registration failed. 

• “Text On” Button property cannot be set if there is no “Text Off” entry. 

• Erratic Time Display of task when WaitFor is used. 

• Variable Timecode type displayed in the variable lister is not correct, it is always 100fps. 

• Impossible to change Font/Size properties in the Device Map property box. 

• Quit (Reboot) Manager command doesn’t work properly under WindowsXP. 

• Wrong error code returned by OpenCapAPI/OpenCapXML StartTask command (“WrongState” 

instead of “Success”). 

• Some projects can generate a Manager crash on loading. 

• Manager does not support multiple instances. 

• Manager and ManagerPanel instances limitation are confusing. 

• Some objects don’t keep their properties in WebPanel. 

• Device Control Panel doesn’t open if the container name parameter is not referenced. 

• MON Variables are sometimes duplicated after connection to the server. 

• MON Variables are corrupted after Project import. 

• Password Character does not use Text Color in Panel and WebPanel. 



Medialon Manager Version 6.0.3 

Medialon Manager p 42 of 50 

M539-3 | January 2024 

• GetEnumCount() returns the count in the “Text” return variable instead of “Index/Count”. 

• MON devices in a Showmaster cannot connect to a Manager. 

• Task internal consecutive commands may not be executed properly such as Stop/Play cues 

adressing the same task. 

• Copy/Paste of a List Control object changes the object reference. 

• Wrong messages after a project loading. 

WebPanel 

• Duplicate UserScreen in a WebPanel after a V5 project is imported. 

• WebPanels are not refreshed properly on the first load on Android. 

• High CPU usage when rendering sliders in a WebPanel (browser side). 

• A WebPanel button stays down if tapped on a long time on iOS or Android. 

• WebPanel takes a long time to display a large project. 

• Text Edit doesn’t handle special characters (such as &amp or %) in WebPanel. 

• Slider and DigitalSlider are not always properly displayed in WebPanel. 

• “Edit Type” property has no effect in WebPanel Edit object. 

• List graphical object is not correctly refreshed in WebPanel. 

• WebPanel is frozen sometime when List or DigitalSlider graphical object are used. 

• Lines are always displayed under a Square even if the Square is created before the Lines. 

• Android browser crashes while typing a text in an Edit object in the WebPanel. 

• When the UserScreen is ‘fullscreen’, it’s not automatically displayed with position top=0 left=0 

in WebPanel. 

• Line and Circle from a background page are displayed over the static objects of the current 

page. 
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Medialon Manager Version 6.0.2 

Bugs solved 

Manager 

• “Goto Line” (or “Goto Label”) cue is not executed if it is the last cue of a task. 

• Virtual Screen resolution doesn’t match the real screen resolution. 

• Crash after a resource has been deleted. 

• It’s not possible to create more than 2 Manager On Network devices with Manager Kiosk. 

• Representation of Gauges are not correct. 

• Device variables (except Activity and Positrack) are not shown in the “All Variables” lister. 

• MON API and OpenCapXML clients are not notified when a variable is renamed. 

• When WebPanel Server is activated and File->New Project is selected, WebPanel Server is de-

activated but never activated again when a WebPanel is used. 

• MXM and MRC help is not available. 

• A wrong MXM version error message is generated when a task’s export project is loaded. 

• If an import project error occurs and the current project is not already saved has user bitmaps, 

a wrong error message is generated about missing image folder. 

WebPanel 

• Representation of Gauges are not correct. 
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Medialon Manager Version 6.0.1 

Bugs solved 

Manager 

• Watchdog is not activated. 

• The Update Cue Confirmation dialog appears several times at the end of recording. 

• Tip of the day menu doesn’t open when Manager has been started by double clicking on a 

Manager project. 

• Task Control Panels are incomplete in the Control tab. 

WebPanel 

• Cannot type login/password on the login page of WebPanel when using an iOS or Android 

device. 

• Manager Local Panel and WebPanel multiline TextEdits behave differently. 

• WebPanel doesn’t show images if the Manager project is double clicked from a network 

location (i.e. \myserver). 
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Medialon Manager Version 6.0.0 

What’s new in Manager V6 

Web Panels 

iPad/Android/WebBrowser compatibility: Web Panels allows to simply and dynamically convert 

UserScreens (touch panels) designed in Manager into HTML5. These Web Panels are hosted by a 

web server built into Manager V6 and can be displayed in any HTML5 compatible devices. 

MxM SDK 

The Medialon MxM SDK is a tool allowing users to develop native MxMs for Manager and 

Showmaster such as complex drivers or sub applications. 

Enhanced Ergonomy and functionalities 

• More intuitive ergonomics: programming in Manager V6 has been improved to be smoother 

and easier for the programmer. 

• JPG and PNG images are now natively supported. 

• Char(…) function in expressions has been added. 

• ‘Activity’ and ‘Positrack’ variables have been added to devices. 

• Device ‘Activity’ and ‘Positrack’ menus have been replaced by properties in the object 

inspector. 

• Command to get the ‘Activity’ and ‘Positrack’ status of a device has been added. 

• Variable creation feature has been added into the variable dialog selector. This will ease the 

process when a command needs a return variable. 

• Image Selector is now accessible from the Tools menu (for image deletion for instance). 

• Drag’n’drop of a page into a task creates a Goto page cue. 

• Drag’n’drop of a UserScreen into a task creates a cue Open UserScreen. 

• Medialon logo has been added to standard bitmap list. 

• Buttons for ‘Send to front/back’ and ‘Align’ have been added to the toolbar of the screens-tab. 

• Font, color, and text size properties have been added for UserScreen’s Gauge. 

• Default Font Size parameter has been added in the Manager Preferences. 

• A multiline zone has been added in the Preferences->Projects to store more detailed project 

information. 

• “Don’t ask me again” option has been added to the confirmation dialog when tasks are deleted.
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Licence and 3rd party Software 

The End User Licence agreement and the overview of all 3rd party Open Source SW packages can 

be found on the 7thSense user portal. 

 

 

https://portal.7thsense.one/online-help/index.html?medialon_library.html
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